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WSDOT AGi32 Basics (AGi32 v 16.6)
This is a self-study tutorial for designing and analyzing roadway illumination systems for WSDOT installations using AGi32 version 16.6. If you
do not have this version, contact your IT Help Desk for installation. This is the current version for use at WSDOT, and is necessary due to
changes in some of the cloud based services now tied into AGi32. This tutorial cannot be used for previous versions of AGi32 due to the
significant changes between AGi32 version 16.6 and previous versions.

If there are any questions about this training or the use of this
software for WSDOT applications, please contact us:
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For WSDOT Staff:
If you do not have AGi32 version 16.6 installed, contact your IT
Help Desk for installation. If there are any issues with getting
AGI32 version 16.6 installed, or if you get a message about setting
up the license server, please contact us at HQ traffic for assistance.

Note: AGi32 is a registered trademark of Lighting Analysts, Inc.
For more information, see http://www.agi32.com.
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Section 1 – Setting Up AGi32
When first starting AGI32, the screen should look something like this:

Your background may be white. It is highly recommended that you change the background color to black – addressed on pages 1-4 and 1-7.
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On the main screen, in the lower right corner, set the toggle buttons as shown:

Only the Toolkit and Statistics should be on (off shows the “Do Not” red circle and line). Units should be ft-Fc (feet – Foot-candles). The
“Refresh” traffic signal is only a status indicator. You may turn the statistics window off until you run a calculation, if desired.
Under the “Tools” menu, choose “System Settings”:
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On the Units tab, verify that it matches the following:
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On the Defaults tab, make the following changes:

1
2

3
4
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1. Change the “Default System Font” to Arial by clicking the “Change” button. The Font window will appear:

Find Arial in the list and select it, then click “OK”
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2. Change the Default Luminaire Symbols by clicking on the “Select” button to the right of each line. The Luminaire Symbols window will
appear:
Find the “CIRCLE
UP_DOWN” symbol in the
library (usually one full page
down) and click on it. Verify
that it appears in the Selected
Symbol window in the bottom
right, then click “OK”.
The process is identical for
selecting both the Render and
Model symbols. The
windows are slightly different
– the information on the right
edge of the window is slightly
different, and the rendering is
shown differently. The Model
window is shown at right; the
Render “Selected Symbol”
graphic is shown below:
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3. Click on the color box for the “Model Mode Background”. Select black in the window that pops up, then click “OK”

4. Change the number in the Dimensions, Precision (decimals) to 2 by either typing it in or using the arrow buttons.

After completing these steps, click on the “Advanced…” button on the right side of the window for some additional changes.
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In the Advanced Settings window, under the General Tab, change the “Initial Curve Increment (Degrees)” to 1:

Check the “Save Settings as Startup Defaults” box, and then click “OK”.
Back in the System Settings window, check the “Save Settings as Startup Defaults” box, and then click “OK”.
These settings should not require any changes so long as you are using this version of the AGi32 software.
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Section 2 – Preparing a CAD File for AGi32
Create a new CAD base file for export to AGi32. Recommended practice is to add a “_for_AGI” suffix to the existing base file (Ex:
XL1589_BP_IL_for_AGI.dgn).
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Detach references that do not contain necessary data. Merge any remaining references into the master file. References do not consistently export
properly, so it is recommended to not have any references attached to the file you plan to export to AGi32.
Open the references window.
Right click on the reference you want to merge
and select “Merge Into Master”.
All reference data will be merged into the current
base file. For this reason, it is recommended that
a separate base file be created for CAD exports to
AGi32.
Data that should be included, at a minimum:
-
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Roadway and shoulder edges
Pavement markings
Right of Way lines (R/W is limited)
Drainage features
Structural features (bridges, sign
structures, etc.)
Other potential obstructions or
topographic features which may affect
placement of poles.
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Delete as much extraneous information as possible – this helps keep the CAD data in AGi32 to a minimum.
Before cleanup (data to be deleted is highlighted in yellow):
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After cleanup:

Some data you may wish to keep for reference (such as the railroad tracks and north arrow shown here).
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Export the CAD file to .DXF format:
Under the File Menu, choose “Export”, and then
“DGN, DWG, DXF…” in the dropdown to the right.

Change the “Save as type” to “Autodesk(R) DXF Files (*.dxf) in
your AGI folder:

Your CAD file is now ready for use in AGi32.
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Section 3 – Importing CAD Files
In AGi32, Import a CAD file using one of the following methods:
Under the File Menu, select Import, and then CAD File…

At the top of the screen, in the toolbar, click on the small arrow
next to the larger down arrow and select CAD File…

Browse to your AGI folder and select the DXF file that you previously created:
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After selecting your file, click “Open”. The Import CAD File window will appear:
On the Import Options tab, change the
Units Specified in CAD File to “*?* Feet
*?*”, if it doesn’t already show it. After
you have done this once, it should default
to this setting.
Uncheck the “Import Text” and “Import
Block Attributes” checkboxes.
If there are any layers that you know you
do not want included, you can deselect
them here by clicking on them.
Deselected layers will not be imported.
*DO NOT CHANGE THE SCALING
FACTOR*
If you change the scaling factor, you will
not be able to directly import you
luminaires back into CAD in their proper
locations.

Switch to the Advanced Options tab.
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On the Advanced Options tab, verify that the Curve Increment box shows “1”:

Click the “OK” button.
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The Import Summary tab will appear after processing:
This window will let you
know if there are any
errors and any items that
weren’t imported.
It is normal for Text,
Points, and Hatches not to
be imported (as shown at
left). Block References do
not necessarily need to be
imported either. If any
other entity types show up
in the “NOT Imported”
column, then you are most
likely missing line work
that you may need to do
your analysis.

After checking the summary, click on the “OK” button. The AGi32 window will show the extents of the CAD data that you just imported.
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If you haven’t already done so, save your AGI file. Recommended naming convention is P????_IL_AGI or XL????_IL_AGI. The file type suffix
(.AGI) will be added automatically.

After naming the file, click “OK”. The File Information window will pop up.
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In the File Information window, you may choose to add descriptive information such as a description of the location or iterative information on
changes if you’re making revisions to a previous design:

When you are finished making any changes, click “OK”. Your file is now saved. If you hit “Cancel” on this screen, the file will not be saved.
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Section 4 – Getting Around in AGi32
Basic View Controls - Mouse Shortcuts:
The mouse scroll wheel will zoom in and out, centered on where the cursor is (*not the center of the current view*). Example: if you use the
scroll wheel while the cursor is in the upper right corner of the window, it will zoom in or out centered on that location:

The center of the crosshairs (circled in red above) will become the new center of the window if you use the scroll wheel to zoom.
If you click and hold the scroll wheel, you can pan the window around (similar to CAD) as long as you hold down the scroll wheel. This is the
same as selecting the Pan tool from the view toolbar.
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Basic View Controls – Toolbar Commands:
The View toolbar is the majority of the AGi32 toolbar. It contains both 2D and 3D view controls, as well as redraw tool and view manager.

2D View Tools

3D View Tools (Not Covered in this Tutorial)

Redraw current view – helpful to remove ‘ghost’ lines from moved luminaires, deleted items, etc.
Pan Tool
Zoom Window Tool: Zooms in on an area based on a rectangle defined by
two opposite corner points.

Zoom Window
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Zoom Extents Tool:
Zooms out so that all elements are visible (both
drawing elements and AGI32 elements such as
luminaires, templates, and grids.

Zoom Limits Tool:
Zooms out to the limits of the overall drawing
area. In a typical file, this will be so far out that
you won’t be able to see what you’re working on.
Rarely used, if ever.
Previous View Tool: Restores the view
presented prior to your last view change.
Zoom Extents

Plan (or top) View Tool: Returns the view to
overhead (plan view) zoomed out to maximum extents (like the Zoom Extents Tool). Useful if you have accidentally clicked on one of the 3D
view tools and the Previous View tool doesn’t get you back to plan view.

3D View controls are an advanced feature not used on most projects, and are therefore not covered by this tutorial. 3D work is limited to major
freeway interchanges with multiple levels of roadways where light from upper roadways affects lower roadways.
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View Rotation
Since AGi32 relies heavily on rectangular grids, it is helpful to rotate the view such that the roadway runs left to right or top to bottom on the
screen.
To rotate the view in AGi32, select Plan-Rotated under the View menu:
You will then set the view X-Axis using two points. The first point will set the pivot point for
the rotation, and the second will set the direction of the X-Axis.

The screenshot at left shows the first point (lower left) and
the second point about to be placed (upper right). The XAxis of the view will follow the line between these two
points.

The screenshot at right shows the end result of the view rotation. Note that after
rotation, the view automatically zooms to extents (drawing element limits).
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Section 5 - Defining Luminaires
In the Model Toolkit window, select the “Luminaire” tab:
Under this tab, click on the “Define” button:

.

This will bring up the Define Luminaire window:

Before doing anything else, ensure that “Smart Symbols” is turned off at the top of the window.
In the Define Luminaire window, select the “Instabase” button:
This will bring up the “Instabase In The Cloud” window.
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Instabase In The Cloud:

The Instabase will initially be blank, with no manufacturers selected.
This tutorial will only step through adding the standard Type III distribution, medium, cutoff, HPS luminaire used by WSDOT for lighting
analysis. For adding other luminaires, see Appendix A.
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In the Instabase window, click on “Select Manufacturers” in the upper left corner:

This will bring up the Instabase Selection window:
To simplify selection, it is recommended to roll up all of the trees by clicking on
the “-“ button to the left of “Unselect All”.
With the trees rolled up, click on the “+” to the left of GE Lighting, then check the
box next to “GE Lighting Solutions”.

Once this box is checked, click the “OK” link at the bottom right of the window.
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The Instabase window will update and now show GE Lighting Solutions:

To get to the correct file, enter 451002 in the Text Search box in the lower left part of the window:

Then Click on “Run Search”.
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Click on the expand all “+” to show the file in the tree (which has now been filtered):

Check the box next to the file, then click on “Download to AGi32” at the bottom of the window.
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The Define Luminaire window will update with the new luminaire:
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For all luminaires, the Total Light Loss Factor must be changed:
In the Definition area of the Define Luminaire window, click on the “Specify…” button to the
right of the Total LLF box:
This will bring up the Light Loss Factor Specification window:

Change the following entries:
LLD: 0.73
LDD: 0.85
Verify that the Total Light Loss Factor at the bottom of the
window is 0.621, then click on the “OK” button.
The Total LLF will have updated to 0.621:
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The following changes vary with each luminaire wattage and mounting arrangement:
The following example is for a 250W HPS fixture installed at a 30 ft mounting height (H1) with a 12 foot arm:

F
G

A

D
E

B
C

H
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A - Pole Length: Click the radio button next to “Static: Length =”, then enter the H1 height (in this case, 30 for a 30 ft mounting height). Note:
this only defines the drawn post length for the pole vertical – it does not set the luminaire height above the ground. The actual placement
height is done later.
B – Arm Arrangement: The default is a single arm.
To change to a double arm, click on the graphic to
bring up the Luminaire Arrangements window. For a
double arm pole, select the “BACK-BACK”
arrangement.
C – Arm Length: Enter the arm length plus an
additional 1.5 feet. In this example, a 12 foot arm is
entered as 13.5 feet. This is because AGi32 defines the
insertion point by the center of the luminaire glass.
D – Lumens Per Lamp: This defines the initial
lumens output by the luminaire. For a 250W HPS
luminaire, enter 28000. The following table shows the
lumens to enter for standard wattages:
Wattage
200
250
310
400

Lumens
22000
28000
37000
51000

E – Luminaire Watts: This defines the actual power consumed by the luminaire. This is not critical, but should still match the luminaire being
used. For a 250W luminaire, enter 314. The following table shows the watts to enter for standard wattages:
Wattage
200
250
310
400

Actual Watts
248
314
387
479
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F – Label: This is a shorthand “tag” for each luminaire type. Due to the way some of the editing tables are set up in AGi32, a standard labeling
scheme has been developed that will fit the character limits of these editing tables. For a 250W luminaire mounted at 30 ft with a 12 ft mast arm,
the label should read “250 12-30 3-M-C”. For other luminaire variations, see the following table:
Wattage
200
200
250
310
400
400

Arm Length (ft)
16
8 (Double Arm)
16
12
12 (Double Arm)
16

Mounting Ht (ft)
20
20
30
40
40
50

Distribution
Type III – Medium - Cutoff
Type III – Medium - Cutoff
Type III – Medium - Cutoff
Type III – Medium - Cutoff
Type III – Medium - Cutoff
Type III – Medium - Cutoff

Label
200 16-20 3-M-C
200 D8-20 3-M-C
250 16-30 3-M-C
310 12-40 3-M-C
400 D12-40 3-M-C
400 16-50 3-M-C

Labels are constructed as follows: AAA BBB-CC D-E-F, where
-

AAA is the luminaire wattage (200, 250, 310, 400, etc.)
BBB is the arm length in feet and type (Single Arms: 8, 10, 12, 16, etc.; Double Arms: D8, D10, D12, etc.)
CC is the mounting height (H1) in feet (20, 30, 40, 50, etc.)
D is the Distribution Type (3 = III, 2 = II, 5 = V, etc.)
E is the Distribution Distance (M = Medium, L = Long, S = Short, etc.)
F is the Cutoff Type (C = Cutoff, NC = Non-Cutoff, etc.)

G – Description: This is the longhand label for each luminaire type. Here, you should type out and expand on the information in the label field.
For example, for the “250 12-30 3-M-C” 250W luminaire, the description would read:
GE 250W HPS 12ft Arm 30ft III-Medium-Cutoff
Although the IES file information is still included in the Photometric File Description in the lower left hand corner of the screen (Item H), the
manufacturer is added to the description (in this case, GE) as a reference to the source IES file.
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Once this has been updated, click on the “Add/Redefine” button on the right side of the window. The updated luminaire will be added to the list:

To remove the placeholder file (GE451002), check the box next to the label, and then click on the “Delete” button.
If you have made a mistake in the Label field, you can click the “Relabel” button to correct it. Any other errors require you to click the
“Add/Redefine” button instead.
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To add additional luminaires which share many of the same characteristics, the simplest way is to modify an existing definition and then click
“Add/Redefine”. So long as you have used a different label, it will add each new luminaire to the list. If you do not change the label, then you
will overwrite the existing definition for that label with the new information.

In the above example, only the Pole Static Length has been changed (from 30 to 40 – circled in red). Note that a warning box has come up on the
right, alerting that a change to the definition has been made.
If the Label is not changed, the “Add/Redefine” button will function as Redefine, and will change the definition of the luminaire with the label
250 12-30 3-M-C. If luminaires with this label have already been placed, it will change all of those luminaires as well.
If the Label is changed, then the “Add/Redefine” button will function as Add, provided the new label does not match any other existing luminaire
label in the list, and a new luminaire definition will be created.
Using Add/Redefine to add similar luminaire definitions can save a lot of time, as only basic changes need to be made to each definition –
typically lumens, wattage, height, arm length, and / or arm arrangement – definitions do not need to be entered from scratch every time.
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After adding multiple luminaires, you will end up with a list that looks something like this:

To sort the list, click on the “Label” header.
Once you have finished adding luminaires, close the window by clicking the “Close” button on the right side of the window.
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Changing Luminaire Symbols
In the event the luminaire symbols aren’t coming in automatically as CIRCLE UP_DOWN, you can change the symbols yourself. Note that this
has no effect on calculations – it merely changes how the luminaire is displayed (drawn) in AGi32.
To change the luminaire symbols:
In the Symbols portion of the window, click on the upper symbol (in this case SHOEBOX) to bring up
the Luminaire Symbols window.

In the Luminaire Symbols window, scroll down and
select “CIRCLE UP_DOWN”.
Verify that CIRCLE UP_DOWN appears in the
Selected Symbol area to the right, then click the “OK”
button.
Both symbols will be updated in the Symbols area of
the Define Luminaire window:
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Creating and Using a Collection
To avoid the need to define the same luminaires repeatedly for multiple projects, it is highly recommended that you create a Collection. A
Collection is a set of luminaires that are defined and stored on your computer’s local hard drive (you cannot change this to an alternate location
like a network drive at this time) which will store everything but the label for any defined luminaire. These will be available for any AGi file.
To create a Collection, click on the Collection button at the top of the Define Luminaire window:
This will bring up the Luminaire Collection window.
First, click on the “New…” button at the bottom of the window to
create a new collection. This will bring up the Create Collection
window.

Type a name for the new collection in the Collection Name box at
the bottom of the window (such as WSDOT Std HPS), then click the
“Add” button.
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The new collection name will appear in the list of Collections at the top of the window.
After naming a collection, click the “Close” button. The new collection name will now appear
in the dropdown list at the bottom of the Luminaire Collection Window.

With a collection name, luminaires can now be added to the collection. Select the
luminaires to be added to the collection at the top of the window (shift click and Ctrl
click can be used to select multiple luminaires). After selecting the luminaires to be
added, click the down arrow button next to “Add Selected Luminaires to Collection”.
The luminaires will be added to the collection, listed by their Description. Note that
the labels are not included in the collection definitions.
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To add a luminaire from a collection to the luminaire definitions, click on the
Collection button at the top of the Define Luminaire window. For a file with no
previously defined luminaires, the Luminaire Collection window will look something
like the window shown at right.
To add a luminaire, select the luminaire(s) to be added from the list at the bottom of
the window. Click on the up arrow next to “Add Selected Luminaires to Defined
List” to add the luminaire(s) to the file’s luminaire definitions. After clicking the
arrow, the Collection Labeling window will appear.

Click the button next to Manual Labeling, and then click in the blank space under
the Label header. Enter a label following the standard labeling scheme previously
defined in this section. If you selected multiple luminaires, there will be a line for
each luminaire selected. After entering the labels, click the “OK” button. The
luminaires will now appear in the top of the Luminaire Collection window with
their labels. Click the “OK” button, and the luminaires will now be listed in the
Define Luminaires window.
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Section 6 - Adding Calculation Areas
To place calculation areas, click on the “Calculations” tab in the Model Toolkit window:
There are three types of calculation areas that will be used: Calculation Points – Polygon,
Calculation Points – Road, and Statistical Areas.

Calculation Points – Polygon:

A
B

In the Calculation Points – Polygon window, change the following items:
Label (A): Change to a basic description that is easy to remember.
Underscores are recommended instead of spaces.

C
Point Spacing (B): Both the Left-To-Right and Top-To-Bottom values
should be 5 feet.

D
Summary (C): Only Average, Maximum and Minimum, and
Average/Minimum Ratio should be
checked.
Display Options (D): Polygon Lines
Visible and Mark Points should be
checked. Change the decimals to 2.
Change the color by clicking on the color swatch. Recommended colors are red, blue, green, orange, and
magenta (as shown at right), as these are visible on both white and black backgrounds.
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Click the “OK” button after making these changes. The grid area is then placed by clicking at points along the perimeter. To remove the last point
clicked without starting over, use “Ctrl Z” on the keyboard (backtrack as many points as desired). Segments between points on curves will require
points spaced closer together to approximate the curve. After clicking the last point, right click to finish the shape. The end result should be
something like this:

The grid boundaries are visible in red, and the point placeholders are shown with “?” symbols. These will change to numbers after calculation.
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Place any additional grids as needed. It is recommended that different colors be used for adjacent grids to aid in determining where one grid ends
and the next begins. The example shown below shows three adjacent grids for a highway intersection (note that only the intersection area is
actually required – the turn pocket areas are shown only as an example of adjacent grids).

*Note: This screenshot uses a white background for clarity only – black background is more visible on a computer screen.
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Calculation Points – Roadway:
The Calculation Points – Roadway grid is used for veiling luminance. It can also be used for straight sections of uniform width roadway in one
direction, if desired. These grids are directional, and rely on a specific direction of travel.
Calculation Metrics (A): Only Roadway
Luminance and Veiling Luminance should be
checked. Click on Veiling Luminance to ensure
that the indicator arrow (black triangle) is
pointing at Veiling Luminance.

A

General Section (B):

B
C

Change the Label to something brief but useful.
Ensure that the Roadway Standard selected is
IES RP-8-14 (choose from dropdown if
needed).

E

F
D

Change the Number of Lanes to the total
number of lanes in the same direction of travel
for the entire length of the calculation area. Too
many is better than too few.
Change the Set Spacing to 5 for the Point
Spacing Along Roadway Based On.

Roadway Surface (C): Change to “R2 (Diffuse And Specular), Q0=0.07”.
Selected Metric Summary (D): Check only Average, Maximum and Minimum, and Maximum Lv/LAvg Ratio.
Selected Metric Display Settings (E): Change the color to something different from both adjacent grids and grids that will be overlapped.
General Display Settings (F): All boxes should be checked.
After making these changes, click the “OK” button to place the grid.
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Roadway grids are rectangular and placed using three points. The first point is on either the right or left edge of the lane(s) to be covered at the
farthest upstream point. The second point is on the same lane edge (left or right) as the first point, but at the farthest downstream point. The third
point is at the same downstream point as the second point, but on the opposite side of the lane(s):

3

1
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The resulting grid will look something like this:

Roadway grids for Luminance and Veiling Luminance show observer points in advance of the grid. Veiling Luminance requires a minimum flat
tangent section of 272 feet in order to be calculated. For an effective measurement the grid should be a minimum of ??? feet beyond the initial
272 feet of tangent section, for a total minimum tangent section length of ??? feet. Any curvature, horizontal or vertical, invalidates the veiling
luminance calculation, as it places the observation point in a location where a driver cannot physically be.
In the example shown above, the veiling luminance grid is actually too long (to the left), as the observer points drift outside of the lane width
towards the far left of the observer lines (area shown with red dimension line above).
To correct the display of the veiling luminance grid, and to turn off extraneous information (Luminance data), click on the Project Mgr. button at
the top of the view:
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This will bring up the Project Manager window:
There should be two items in the upper list: your project, and your
imported CAD file. To adjust the veiling luminance grid colors, check the
box under the “Load” column next to your project (in this case, Project_1).
Checking the box will populate the Entity portion of the window at the
bottom:

Since no luminaires have been placed, the dropdown in the upper left portion of this area will only list “CalcPts”. Clicking on the “Label” header
in the table will sort the list alphabetically by label name.
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To display only the veiling luminance grid (and summary data), boxes in the columns should be checked as follows:
Enabled (A): All checked;
Lock (B): All unchecked;
Vis (C), PtsVis (D), LnVis (E) and Sum (F): All checked except for luminance grids.
The example shown below has the boxes checked correctly. As an aid, only grids with “Luminance” in the CalcType column or with black in the
color column should be turned off (Vis, PtsVis, LnVis, and Sum). Unchecking the Enabled box will disable all associated grids, including the
veiling luminance grids tied to luminance grids. This example also shows a combined Illuminance and Veiling Luminance grid (Southbound).

A

B

C

D

E

F

It may be necessary to scroll right to see all columns. Alternatively, the window can be stretched until all columns are visible (as shown here).
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After making these changes, click the “OK” button. All grids will now show the correct colors. For a combined Illuminance and Veiling
Luminance grid, when both grids are turned on only the Illuminance grid will be visible.
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Editing a Grid
To make changes to a grid, click on the Edit Calculation tool:
Click on any point or edge of the grid to be edited (for Roadway Veiling Luminance grids, you can also click on the observer lines outside the
grid).
Either the Calculation Points – Polygon or Calculation Points – Roadway window will pop up (depending on the type of grid selected).
Make any changes needed in the window. If the grid needs to be redrawn, click on the “Re-Specify Polygon…” (Polygon grid) or “Re-Specify
Roadway…” (Roadway grid). The grid will have to be placed from scratch using the same methods described above for placing each grid type.
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Optional - Statistical Areas
Statistical Areas can be used to evaluate multiple areas at the same time, for an overall picture of the lighting in an area.
To place a Statistical Area, AGi32 must be in un-rotated plan view. The simplest way to do this is
to click on the Plan (or top) View button in the upper toolbar:
After reorienting the view, you can pan and zoom, but you cannot rotate the view if you want to
place a Statistical Area.
Under the “Calculations” tab in the Model Toolkit window, click on the Create Statistical Area tool:
The Calculation Points – Statistical Area window will pop up.
Change the label to something brief, yet useful.
In the Summarize Project dropdown, you can change this to your
current project.
In the Values Type dropdown, ensure that this reads “Illuminance”.
Change the line color to something visible (see page 6-1). Click on the
“Labeling…” button to adjust the statistical area label text. For text
size, anything from 5 to 20 ft should be legible (will depend on size of
area being evaluated).
In the Summary section, only Average, Maximum and Minimum, and
Average/Minimum Ratio should be checked.
Click the “OK” button, and then place the grid as a polygon exactly the
same way as the Calculation Points – Polygon grid was placed.
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After the statistical area is placed, you will only be able to see the perimeter line and the summary data label:
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To make changes to the Statistical Area options, click on the Edit Statistical Area tool
of the Statistical Area, you will have to delete the area and place a new one.

, then click on the statistical area. To change the shape

To relocate the Statistical Area text, click on the down arrow next to the Edit Statistical Area tool and click on
“Move Label”. Click on the text to select it, then click once as a “move from” point (1), and click a second time in
the new “move to” location (2).

2

1

Note that the move from and move to points can be anywhere in the window – the
selected items will move to a new relative location identical to the grey line shown
between the two points (see example at right).

2

Text
Moves
1
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Section 7 - Placing Luminaires
To place luminaires, click on the Luminaire tab in the Model Toolkit window.
Choose the luminaire type to place in the Label drop down. This is one location where the
shorthand label helps, by allowing the window to stay narrow.
After selecting the luminaire type, enter an installation height in the MH box. *This is very
important!* This sets the height of the luminaire above the roadway. If the MH is left at zero,
the luminaire will be on the ground. Do not change any other values.
The placement tool should say “Locate & Orient”. If it
does not, click on the down arrow and select “Locate &
Orient”. After doing this once, it should default to this
option automatically.
Click on “Locate & Orient”. A luminaire outline will
now appear under the cursor.
The insertion point for the luminaire is the pole location, with the luminaire shown at the end of the mast arm with a cross-hair (for ease of
location). Clicking once places the pole. The luminaire arm can now be rotated to the proper orientation. Rotate the arm to the proper location,
then click again to set the luminaire. The luminaire should be placed such that the crosshair is over the fog line.

Locate
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Before placing any additional luminaires of the same type, create a luminaire template.
To create a luminare template, click on the Toggle Templates On/Off Tool.
This will bring up the Template Settings window.

Variable isolines are easier to see. Enter 0.1 for green and 0.2 for red.
Then click “OK”. The isoline template will be generated automatically for
all luminaires at the height they were placed (the MH value entered for each
luminaire).
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When placing additional luminaires, an outline of the template will now
be visible. With the template visible, it is easier to arrange luminaires.
Ideal arrangement is such that the green (0.1 fc) lines from adjacent
luminaires cross at the outside edges of the calculation area(s).

The example below shows such a crossing circled in red. Note that since this particular example ended up requiring consecutive luminaires on the
same side of the roadway, the far side of the roadway from the red circle actually has more overlap than an alternating side arrangement.
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Crossing the green lines is an effective starting point. Over the course of analysis, the luminaire spacing may need to be adjusted closer together
or farther apart. The example below shows where the luminaires had to be spaced closer together, in this case to achieve proper uniformity across
the entire design area.

It is not recommended that the template footcandle values be changed between calculations, as they provide a valuable spacing reference for
placement. Intial layout of luminaires should look something like this:
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One option for placing additionalluminaires is to copy them. To copy a luminaire, click on the
Copy Luminaire tool.
Click on the luminaire (or luminaire template) to be copied. At the bottom left corner of the
screen, the status box will let you know that a luminaire is selected (the layout screen won’t
change).

It is possible to select multiple luminaires to copy at once, but this is not frequently useful.
After selecting the luminaire to copy, right click to ‘activate’ the luminaire. The luminaire (and template) will now turn grey. Copying luminaires
is based off of relative points. Click once to select the move from point – this can be anywhere on the screen. The original luminaire will go back
to color, and a moving grey luminaire will appear with a line back to the point that you clicked.
In the bottom left corner of the screen, you can see the length of this line. This can help if you are trying to copy a specific distance.
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The new luminaire will be copied to a point that is the same distance and direction from the original luminaire as the line from the first clicked
point.

1: Original point clicked
2: Location of mouse pointer
4

2
1

3: Original luminaire location
3

4: New (copied) luminaire location
(not set until clicked)

After you have positioned the copied luminaire in the desired location, click to set it. Note that when copying a luminaire, the arm orientation
does not change. Orientation can be corrected by rotating the luminaire.
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To rotate a luminaire without relocating the pole, click on the Re-Orient Luminaire tool.
Click on the luminaire (or luminaire template line) to be rotated. The luminaire will turn grey and will
freely rotate about the pole insertion point.

Rotate the luminaire to its new position, and then click to set it. Normally, corner luminaires should be at either 90 or 45 degree angles. In the
above example, these were later adjusted to 45 degree angles.
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Once your initial layout is complete, it is recommended that you run a calculation to see how your initial placement works (See Section 8 –
Calculations).
After running a calculation, you may need to modify your layout. To move a luminaire, click on
the Move Luminaire tool. Click on the luminaire you want to move (either the luminaire itself or
one of the template lines). Click a second time (2) to set a move from point. Click a third time (3)
to set the move to point. The luminaire will move the same distance and direction as shown by the
move tool line:

The move tool will stay active until you right
click (Note: this is different from previous
versions of AGi32).
If you need to delete a luminaire, click on the
Delete Luminaire tool. Select any luminaires
that you wish to delete, and then right click to
delete them.
3
2
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To modify a luminaire’s characteristics, click on the Edit Luminaire(s) tool.
Click on any luminaires that you wish to edit, and then right click to bring up the Edit
Luminaires window.

Any item in the table may be revised. To change
the mounting height, click on the value in the “Z”
column and type in the new value. To change the
luminaire type, click on the drop down in the
“Label” column. This is where the label shorthand
is most useful. Although it is possible to expand
the width of the columns in this window, the Label
dropdown will always be a fixed width (see
example at right). The label shorthand was
developed to help overcome this issue.
The “Bulk Modifications…” button is addressed in
the following section.
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Bulk Modifications
Bulk modifications allow for making changes to large
numbers of luminaires grouped in one of two ways:
1. All luminaires in a project
2. All luminaires with the same definition Label.
To use bulk modifications, select any number of luminaires
with the Edit Luminaire tool. When the Edit Luminaires
window comes up, click on the “Bulk Modifications…”
button in the lower left corner.

The Bulk Luminaire Modifications window will pop up. This
window has two main sections: Apply Modifications To, and
Modifications.
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Apply Modifications To
This section determines which luminaires will be modified.
There are three ways to select luminaires:
1. All Loaded Luminaires will modify every placed
luminaire.
2. All Loaded Luminaires of Label will modify every placed luminaire with the selected label. The dropdown list will have all defined
luminaires (see Chapter 5).
3. Selected Luminaires Only will only modify those luminaires selected in the Edit Luminaires window. This can be done by holding down
the Ctrl key and selecting the rows of the luminaires to be modified through Bulk Modifications. You must click in the grey box to the left
of the row you want to select (circled in red below).
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Modifications
There are four subsections of Modifications. Only one can be used at a time. Only the first two are addressed, as Aiming Angles and Aiming
Point are not used on WSDOT projects with the exception of special circumstances. Contact the WSDOT HQ Traffic Office for assistance with
these sections.
Modifications - General:
Select the General button if you want to completely change
the luminaire type to a different luminaire definition. Check
the box next to Label and then select the new luminaire
definition to be used. The associated description will appear
in the Description box.
Channel is part of features that are not used by WSDOT and are not covered in this tutorial.
Modifications – Location:
Allows for changes to the X, Y, or Z (Mounting Height) of the
selected luminaires. This section is most useful for changing
the mounting heights of multiple luminaires at once.
However, if the X or Y coordinates are the same for many
luminaires, such as along a straight stretch of roadway, then
offset adjustments can be made in groups if the road or
shoulder width changes. Only the coordinate(s) checked will be modified.

After selecting which luminaires to modify, and what modifications to make, click the “OK” button. The selected modifications will be made, and
you will be returned to the Edit Luminaires window. Any luminaires listed that were affected by the bulk modification will show the new values
applied. Click the “OK” button again to close the Edit Luminaires window.
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Section 8 – Running Calculations
After setting up calculation areas and placing luminaires, calculations can be run.
To run the calculations, click on the Calculate button (or hit the F12 key):

The button should show red lines going down from a luminaire and then up at an angle. If it shows
anything else, click on the down arrow next to the button and select “Full Radiosity Method”.
For most files, calculations should run fairly quickly. For larger or more complex files with multiple
areas and many luminaires, calculations can take quite a while (up to 30 or 40 minutes for very large files
with 3D analyses, depending on the computer).

While calculating, the title bar of the file will add “AGi32 Calculating…”, and the Calculating…
window will pop up somewhere on the screen.
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When the calculations are complete, click on the Statistics button at the bottom of the screen to open the calculations data (Statistics) window.

The Statistics window will display the calculation results. There are certain values that need to be checked
against the requirements of the table in Exhibit 1040-25, in Section 1040 of the WSDOT Design Manual.
Illuminaince areas will have only a name (in RED), with “Illuminance (Fc)” on the line below the name.
Three values need to be checked on these grids:
-

Average: Must be greater than or equal to Minimum Average Maintained Horizontal Light
Level as required by Exhibit 1040-25 and the applicable Pedestrian/Area Classification.

-

Minimum: Must be greater than or equal to 0.2.

-

Avg/Min: This is the uniformity ratio. This value must be less than or equal to 4 (as required by
the Maximum Uniformity Ratio listed for all locations, except transit stops, in Exhibit 1040-25).
AGi32 only gives the number to the left of the colon in the ratio. In this example, the
“Intersection_Area” uniformity ratio is 3.20:1, which is below the limit of 4:1.

Statistical areas (titles are BLUE) present the same information as illuminance areas, and should have the
same values checked.
Veiling luminance areas (when applicable) use the same name as the illuminance grid (if placed using the
Calculation Area – Roadway tool), with a suffix of “_Veil_Lum” added to it. Veiling grids have one value
that needs to be checked:
-

MaxLvRatio: This is the Maximum Veiling Luminance Ratio. This value must be less than or equal to 0.3 (as required by the Maximum
Veiling Luminance Ratio listed in Exhibit 1040-25). As with the uniformity ratio, AGi32 only gives the number to the left of the colon in
the ratio. In this example, the “Southbound_Veil_Lum” area has a Max Veiling Luminance Ratio of 0.33:1, which is above the limit of
0.3:1.

If any values exceed the allowable limits, luminaires must be revised or relocated until all values meet criteria.
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Highlighting High and Low Values
A helpful way to find areas that need improvement if the Uniformity Ratio (Avg/Min) is too high is to
highlight low values in a grid. Typically, the Uniformity Ratio exceeds limits when the minimum value
in a grid is too low. To highlight low values (and high values) in a grid, click on the Highlight Values
tool in the Calculations section of the Model Toolkit.
In the Highlight Values window,
click on the Illuminance tab, then
check the “Highlight Illuminance
Values” box. Change the Apply
Highlight Color To: to
“Background”, otherwise the color
will cover up the numbers. Finally,
check the boxes next to Maximum
and Minimum – it is recommended
to keep the default red for
maximum and blue for minimum.
Then click the “OK” button.

After clicking “OK”, the high and low values in a grid will be highlighted (see
example at right). These locations can be used to determine where more light
is needed to bring the minimum up in order to improve the Uniformity Ratio.
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Section 9 – Printing Results
After developing a layout that meets the required criteria, the project should be printed for record keeping.
There are two parts to printing the project: printing the data, and printing the layout. Printing the layout from AGI32 is optional, as it can be done
through CAD as well.
To print the data, select “Print Text” under the File menu.
This will bring up the Print Text menu.
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In the Print Text window, set up to print the data as
follows:

1

-

Uncheck the banner box (1)
Check the following boxes:
o User/Job File Information (2)
o Luminaire Definitions (3)
o Calculation Summary (4)

After matching the screen at right, click on the “Print
Setup…” button to select and set up your printer.

2
3
4

It is highly recommended that you print to PDF, so that you can verify you have the necessary information, and can print the output only when a
hard copy is needed. Most WSDOT computers have the PDF995 option as a printer, allowing for direct to PDF file printing. This software is
available to all WSDOT employees – ask your IT Help Desk to install it if you do not have it.
After selecting your printer and paper size, click the “OK” button to return to the Print Text window. Click the “OK” button to print the report.
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The options selected above will print out the following items:
User/Job File Information: Prints all of the data from the File Information
window (see Section 3 – Importing a CAD File), as well as user data and
timestamp information.

Luminaire Definition(s): This will print the luminaire data for luminaires used in
the final layout. It will not print the data for every defined luminaire in the file.
This helps to keep track of the luminaires used.
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Calculation Summary: This prints the data presented in the Statistics window (see
Section 8 – Running Calculations). Each area also includes the type of area
(Polygon, Roadway, etc.), the point spacing, and additional basic grid information.
This is the required calculation data for verification against Exhibit 1040-25 in
Section 1040 of the WSDOT Design Manual.
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After printing the calculation data, the layout may either be printed in AGi32 or transferred to CAD for printing. Printing in CAD may be easier at
times, as adding custom labels (text) is a little simpler, and it may be presented in a plan sheet layout.
To print the layout from AGi32, first zoom out so that the entire calculation area can be visible. Starting from Zoom Extents and then working
inward is usually the simplest method.
After adjusting the view, select “Print” from the File menu. This will bring up the Print window.
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In the Print window, make the following changes:
-

1
2

-

5

3
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Click on the “Print Setup…” button (1). This will bring up the same Print
Setup window as before (for Print Text). Change the paper size to 11x17 to
allow for a larger print. Change the layout to landscape if appropriate.
Keep the output as Color (2). Print to PDF, then print a hard copy in color
or grayscale as desired.
Change the Scale to “Scale to Fit Actual Page Size” (3). This will scale the
drawing limits to fit the paper automatically.
Check the “Center Image” box (4) in the Special Formatting section. This
will center the visible drawing elements on the paper.
Click the “Window” radio button (5) in the What section. Then click the
“Specify Window…” button.

Clicking on the “Specify Window” button will allow you to select the print area,
similar to doing a fence plot in Microstation. The Print Window box will pop up
first. Click the “Specify…” button to draw the print area manually.
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Print Area

After clicking to set the second corner of
the rectangle area, you will be returned
to the Print window. The margins, scale,
and number of pages will have updated.
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The printout should look something like this:

You may then print a hard copy if needed.
Printing from CAD is discussed in Section 10 – Exporting to CAD.
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Section 10 – Exporting to CAD
To transfer the AGI32 layout back to CAD for plan sheet development, start by either clicking the Export File button or selecting “export” from
the File menu.

In the Save As window that pops up, save your file as a “RealDWG 2007 DXF (*.DXF)” type file. DXF files seem to fare better than DWG files,
and choosing an older format is less likely to have compatibility issues with Microstation.

Click on the “Save” button to bring up the
CAD Export window.
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In the CAD Export window, make the following changes:
-

1
-

2

Select only the following in the Export Types section:
Luminaires, Templates, and Calc Points (also include
Statistical Areas, if used). The simplest way to do this
is to click the “Clear All” button, and then check these
three boxes. Note: Templates are included to aid in
locating the luminaires in CAD, as the luminaire line
work can be difficult to see.
Select only the Project Name and Entity Type
(Abbreviated) in the Export Layers section.

Do not change anything in the Export section (scaling, units,
origin). Any changes here will result in the exported file not
lining up with the original CAD file.
In the Miscellaneous section, you may uncheck the “Open
Folder After Export” box.
After making these changes, click the “OK” button to save the
file. Clicking “Cancel” will result in the file not being saved.
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After saving the file, open Microstation. Open the base file where you will place the luminaires for your plans.
Attach the DXF as a reference, using Coincident World. If the “DWG/DXF Units” window pops up, ensure that the Units dropdown says “US
Survey Feet”, then click the “OK” button. Once attached, your CAD file should look something like this:
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The level list for the imported DXF file is shown at right.
The luminaires are divided into three parts:
-

LUM: the actual luminaire (light fixture).
POL: the pole and mast arm.
TMP: the luminaire template.

The calculation points are divided into two parts:
-

CPT: the perimeter of the calculation area.
MKP: the point data for the calculation area.

Place light standard cells based on the pole locations provided by the DXF
file.

After placing the light standards, the DXF file can either be turned off or detached. If updates are required, AGi32 files can be exported using the
same DXF filename, which can then be updated in CAD simply by refreshing the reference files.

Section 10 – Exporting to CAD
WSDOT AGi32 Basics, June 2016

10-4

Printing the AGi32 Layout from CAD (Optional)
The AGi32 layout can be printed from CAD using a standard fence plot, or by setting up a sheet file (or files) complete with title block (see
example below).
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Appendix A - Defining Custom Luminaires (Adding WSDOT Approved LED Luminaires)
This section describes how to add luminaires other than the WSDOT standard luminaires described in Section 5.
This example adds the current WSDOT approved LED luminaires to the luminaire definitions.
In the Model Toolkit window, select the “Luminaire” tab and click on the “Define” button.
This will bring up the Define Luminaire window:

Two different methods will be addressed here – adding files from the Instabase, and adding files stored locally (on a hard drive or network drive).
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A.1 Adding files from the Instabase
To search through the Instabase, click on the “Instabase” button:
This will bring up the “Instabase In The Cloud” window:
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The Instabase may initially be blank, with no manufacturers selected. Manufacturers’ product lists may have to be added in order to search
through them.
In the Instabase window, click on “Select Manufacturers” in the upper left corner:

This will bring up the Instabase Selection window:
To simplify selection, it is recommended to roll up all of the trees by clicking on
the “-“ button to the left of “Unselect All”.
With the trees rolled up, click on the “+” to the left of the manufacturer(s) to be
added. To add WSDOT Approved LED Luminaires, expand the following
manufacturers and select the following product lines:
-
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Acuity Brands
o American Electric Lighting
Eaton
o EATON – STREETWORKS _ FORMER COOPER LIGHTING
Leotek Electronics USA Corp
o Leotek Electronics
Philips Lumec
o Philips Lumec
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Acuity Brands – American Electric Lighting:
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Leotek Electronics and Philips Lumec:

After selecting these manufacturers’ product lines, click the “OK” link in
the bottom right corner to add them to your local Instabase.
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The Instabase window will update and now show the additional manufacturers:

To get to the appropriate luminaires, you will have to expand the appropriate trees. Every manufacturer uses a different tree structure, so some
files will be nested deeper than others. The following example will demonstrate how to add the 200W HPS equivalent LED luminaire from
American Electric Lighting (AEL).
Start by clicking on the “+” next to American Electric Lighting to get the
product group list.
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Next, click on the “+” next to “Roadway Lighting Luminaires”
to get the roadway luminaire models:

Then click on the “+” next to the “Autobahn ATB0” line:
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Scroll down until you find “ATB0_30BLEDE10_XXXXX_R3.ies”. Check the box next to it to select it.
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The following are the tree locations for the following IES files. The Autobahn ATB0 luminaire shown in the example on the previous pages is
included as an aid to following the Instabase tree structure.
+American Electric Lighting
+Roadway Lighting Luminaires
+Autobahn ATB0
(200W)
ATB0_30BLEDE10_XXXXX_R3.ies
+Autobahn ATB2
(250W)
ATB2_40BLEDE10_XXXXX_R3.ies
(310W)
ATB2_60BLEDE10_XXXXX_R3.ies
(400W)
ATB2_80BLEDE85_XXXXX_R3.ies

+EATON – STREETWORKS _ FORMER COOPER LIGHTING
+ROADWAY
+NVN NAVION
+4000K CCT – STANDARD
+1000mA – STANDARD
(200W)
NVN-AE-02-E-U-T3R.ies(1)
(250W)
NVN-AE-03-E-U-T3R.ies(1)
(310W)
NVN-AE-04-E-U-T3R.ies(1)
(400W)
NVN-AE-06-E-U-T3R.ies(1)
Note (1): This should be changing to NVN-AF-… in the near future

+Leotek Electronics
+GC1 NW Type 2 3
+GC1-60F
+Type 3
(200W)
IES GC1-60F-MV-NW-3-XX-700 030315.IES
+GC1-80F
+Type 2
(250W)
IES GC1-80F-MV-NW-2-XX-700 S 060215.IES
+GC2 NW Type 2 3
+GC2-120F
+Type 3
(310W)
IES GC2-120F-MV-NW-3-XX-700 020415.IES

+Philips Lumec
+Roadfocus
+RFL
+R3M
(200W)
RFL-145W64LED4K-T-R3M (S1410222m).ies
(250W)
RFL-180W80LED4K-T-R3M (S1410222m).ies
(310W)
RFL-215W96LED4K-T-R3M (S1410222m).ies
(400W)
RFL-241W112LED4K-T-R3M (S1410222).ies

HPS Equivalents shown in parenthesis - Ex: (250W).

These files are current as of June 6, 2016*.

As an alternative, these filenames can be entered into the Text Search box in the lower left corner of the window (see page 5-4 of Section 5 for
more information on using Search).
*Note: Contact WSDOT HQ Traffic to verify current IES files for LED luminaires.
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After selecting these files, check that the “Selected File Count:” shows 15, then click on “Download to AGi32” (15 assumes that all of the files in
the table on page A-9 are being added).

The luminaires will then be added to the luminaire definitions list. If the Smart Symbols window appears, click on the “Cancel” button (it will
appear for every luminaire added if it appears at all).
Luminaires will be added to bottom of the list in the Define Luminaire
window in the order that they appear in the Instabase:
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A.2 Adding a locally stored file (located on a computer drive or network drive)
To add a local file, click on the “Select” button:
The Select Photometric File(s) window will appear:
In the dropdown menu at the top left
of the window (“Look in:”), select
“This PC” (under Windows 8) or a
similar location which shows all of
your local and network drives.
In the window below, navigate to
where your local IES file is stored.
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After locating the IES file to load, select it – multiple files may be selected by holding down the “Ctrl” key and clicking on additional files. After
selecting the file(s) to load, click the “OK” button. This example uses WSDOT approved high mast LED luminaires.

If the Smart Symbols window pops up, click the “Cancel” button (it will appear for every luminaire selected). As with Section A.1 above,
luminaires will be added to bottom of the list in the Define Luminaire window in the order that they appear in the Instabase.
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A.3 Updating and Labeling LED Luminaires
For all LED luminaires, the Total Light Loss Factor (LLF) must be revised as shown here.
The LLF for LED luminaires is different from that for HPS luminaires. After
clicking on the “Specify…” button to bring up the Light Loss Factor
Specification window, enter the following values for LLD and LDD:

LLD: 0.850
LDD: 0.900
Verify that the Total Light Loss Factor (LLF) at the bottom of the
window is 0.765, then click the “OK” button.
Verify that the Total LLF has updated in the luminaire definition:
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The following changes vary with each luminaire wattage and mounting arrangement:
The following example is for a 200W HPS equivalent LED fixture installed at a 30 ft mounting height (H1) with a 12 foot arm:

F
G

A

D
E

B
C

H
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A - Pole Length: Click the check box next to “Pole” and the radio button next to “Static: Length =”, then enter the H1 height (in this case, 30 for a
30 ft mounting height).
B – Arm Arrangement: The default is a single arm. To change to a
double arm, click on the graphic to bring up the Luminaire
Arrangements window. For a double arm pole, select the “BACKBACK” arrangement.
C – Arm Length: Enter the arm length plus an additional 1.5 feet. In
this example, a 12 foot arm is entered as 13.5 feet. This is because
AGi32 defines the insertion point by the center of the luminaire glass.
D – Lumens Per Lamp: For LED luminaires, do not change the
default value.
E – Luminaire Watts: For LED luminaires, do not change the
default value.
F – Label: Enter the shorthand “label” for each luminaire type. The
shorthand labels for LED luminaires are slightly different from those
for HPS luminaires. An additional marker is added to signify the
manufacturer:
-

A: Acuity (American Electric Lighting / AEL)
E: Eaton (Cooper)
L: Leotek
P: Philips (Lumec)

For a 200W HPS equivalent LED luminaire from AEL, mounted at 30 ft with a 12 ft mast arm, the label should read “200A 12-30 3-M-C”. For
other luminaire variations, see the table on the next page:
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Example Labels for LED Luminaires
Wattage
(HPS Equivalent)
200
200
250
310
250
310
400
400

Manufacturer

Arm Length (ft)

Acuity (AEL)
Acuity (AEL)
Eaton (Cooper)
Eaton (Cooper)
Leotek
Leotek
Philips (Lumec)
Philips (Lumec)

16
8 (Double Arm)
16
12 (Double Arm)
12
16
12 (Double Arm)
16

Mounting
Ht (ft)
20
20
30
40
30
40
40
50

Distribution

Label

Type III – Medium - Cutoff
Type III – Medium - Cutoff
Type III – Medium - Cutoff
Type III – Medium - Cutoff
Type III – Medium - Cutoff
Type III – Medium - Cutoff
Type III – Medium - Cutoff
Type III – Medium - Cutoff

200A 16-20 3-M-C
200A D8-20 3-M-C
250E 16-30 3-M-C
310E D12-40 3-M-C
250L 12-30 3-M-C
310L 16-40 3-M-C
400P D12-40 3-M-C
400P 16-50 3-M-C

Labels are constructed as follows: AAAB CCC-DD E-F-G, where
-

AAA is the luminaire wattage (200, 250, 310, 400, etc.)
B is an indicator for the luminaire manufacturer (A = Acuity, E = Eaton, L = Leotek, P = Philips, etc.)
CCC is the arm length in feet and type (Single Arms: 8, 10, 12, 16, etc.; Double Arms: D8, D10, D12, etc.)
DD is the mounting height (H1) in feet (20, 30, 40, 50, etc.)
E is the Distribution Type (3 = III, 2 = II, 5 = V, etc.)
F is the Distribution Distance (M = Medium, L = Long, S = Short, etc.)
G is the Cutoff Type (C = Cutoff, NC = Non-Cutoff, etc.)
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G – Description: This is the longhand label for each luminaire type. Here, you should type out and expand on the information in the label field.
For example, for the “200A 12-30 3-M-C” 200W equivalent LED luminaire, the description would read:
AEL AB 200W LED 12ft Arm 30ft III-Medium-Cutoff
Although the IES file information is still included in the Photometric File Description in the lower left hand corner of the screen (Item H), the
manufacturer and model ID is added to the description (in this case, AEL AB) as a reference to the source IES file. The following is a list of
examples for each manufacturer:
Manufacturer
Acuity (AEL)
Eaton (Cooper)
Leotek
Philips (Lumec)

Label
200A 16-20 3-M-C
250E D8-30 3-M-C
310L D12-40 3-M-C
400P 16-50 3-M-C

Description
AEL AB 200W LED 16ft Arm 20ft III-Medium-Cutoff
Eaton NVN 250W LED Double 8ft Arm 30ft III-Medium-Cutoff
Leotek GC 310W LED Double 12ft Arm 40ft III-Medium-Cutoff
Philips RF 400W LED 16ft Arm 50ft III-Medium-Cutoff

For reference, the manufacturer and model codes are constructed as follows:
Manufacturer

Model Series

Acuity (AEL)
Eaton (Cooper)
Leotek
Philips (Lumec)

Autobahn
Navion
Green Cobra
RoadFocus

Manufacturer and
Model ID Code
AEL AB
Eaton NVN
Leotek GC
Philips RF

Most manufacturers have a shorthand code for their LED luminaire model series. This code is typically part of the IES file name.
Examples:
Manufacturer
Acuity (AEL)
Eaton (Cooper)
Leotek
Philips (Lumec)

IES Filename
ATB2_60BLEDE10_XXXXX_R3.ies
NVN-AE-03-E-U-T3R.ies
GC1-80F-MV-NW-2-XX-700 S 060215.IES
RFL-215W96LED4K-T-R3M (S1410222m).ies

Model Code
ATB#
NVN
GC#
RF?

Model Series
Autobahn (# is 0 or 2)
Navion
Green Cobra (# is 1 or 2)
RoadFocus (? is S, M, or L)

For a more complete set of examples of Labels and Descriptions, see page A-20.
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Once the luminaire information has been updated, click on the “Add/Redefine” button on the right side of the window. The updated luminaire will
be added to the list:

To remove the placeholder file (ATB0_30LEDE10_XXXXX_R3), check the box next to the label, and then click on the “Delete” button.
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If you have made a mistake in the Label field, you can click the “Relabel” button to correct it. Any other errors require you to click the
“Add/Redefine” button instead.
To add additional luminaires, you can make changes to an existing luminaire definition, and then click “Add/Redefine”. So long as you have used
a different label, it will add each new luminaire to the list. If you do not change the label, then you will overwrite the existing definition for
that label with the new information.
After adding multiple luminaires, you will end up with a list that looks something like this:

To sort the list, click on the “Label” header.
Once you have finished adding luminaires, close the window by clicking the “Close” button on the right side of the window.
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Label and Description Examples for All Manufacturers
Manufacturer

IES Filename

Label

Description

Acuity (AEL)
Acuity (AEL)
Acuity (AEL)
Acuity (AEL)
Eaton (Cooper)
Eaton (Cooper)
Eaton (Cooper)
Eaton (Cooper)
Leotek
Leotek
Leotek
Philips (Lumec)
Philips (Lumec)
Philips (Lumec)
Philips (Lumec)

ATB0_30BLEDE10_XXXXX_R3.ies
ATB2_40BLEDE10_XXXXX_R3.ies
ATB2_60BLEDE10_XXXXX_R3.ies
ATB2_80BLEDE85_XXXXX_R3.ies
NVN-AE-02-E-U-T3R.ies
NVN-AE-03-E-U-T3R.ies
NVN-AE-04-E-U-T3R.ies
NVN-AE-06-E-U-T3R.ies
GC1-60F-MV-NW-3-XX-700 030315.IES
GC1-80F-MV-NW-2-XX-700 S 060215.IES
GC2-120F-MV-NW-3-XX-700 020415.IES
RFL-145W64LED4K-T-R3M (S1410222m).ies
RFL-180W80LED4K-T-R3M (S1410222m).ies
RFL-215W96LED4K-T-R3M (S1410222m).ies
RFL-241W112LED4K-T-R3M (S1410222).ies

200A 12-20 3-M-C
250A 12-30 3-M-C
310A 12-40 3-M-C
400A 12-50 3-M-C
200E 12-20 3-M-C
250E 12-30 3-M-C
310E 12-40 3-M-C
400E 12-50 3-M-C
200L 12-20 3-M-C
250L 12-30 3-M-C
310L 12-40 3-M-C
200P 12-20 3-M-C
250P 12-30 3-M-C
310P 12-40 3-M-C
400P 12-50 3-M-C

AEL AB 200W LED 12ft Arm 20ft III-Medium-Cutoff
AEL AB 250W LED 12ft Arm 30ft III-Medium-Cutoff
AEL AB 310W LED 12ft Arm 40ft III-Medium-Cutoff
AEL AB 400W LED 12ft Arm 50ft III-Medium-Cutoff
Eaton NVN 200W LED 12ft Arm 20ft III-Medium-Cutoff
Eaton NVN 250W LED 12ft Arm 30ft III-Medium-Cutoff
Eaton NVN 310W LED 12ft Arm 40ft III-Medium-Cutoff
Eaton NVN 400W LED 12ft Arm 50ft III-Medium-Cutoff
Leotek GC 200W LED 12ft Arm 20ft III-Medium-Cutoff
Leotek GC 250W LED 12ft Arm 30ft III-Medium-Cutoff
Leotek GC 310W LED 12ft Arm 40ft III-Medium-Cutoff
Philips RF 200W LED 12ft Arm 20ft III-Medium-Cutoff
Philips RF 250W LED 12ft Arm 30ft III-Medium-Cutoff
Philips RF 310W LED 12ft Arm 40ft III-Medium-Cutoff
Philips RF 400W LED 12ft Arm 50ft III-Medium-Cutoff

The examples in this table use single 12 ft arm lengths only – revise as needed for double arms or different arm lengths.
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